04 March 2002

Navy Standard Integrated

Personnel System

(NSIPS)

[image: image1.wmf]
KNOWN NSIPS PRODUCTION PROBLEMS 

20 August 2002

1. INTRODUCTION

This document identifies and describes NSIPS production problems and their impact in the field. These problems have an adverse affect on the accomplishment of an NSIPS capability. Unless indicated otherwise in the USER ACTION COLUMN, users are to call the Customer Support Center (CSC) when they encounter these problems and require CSC’s intervention. Items with an “*” at the beginning and shaded in turquoise are new entries.

The problems listed in this document reflect the state of the NSIPS system as of  2 August 2002.  This document will be added to the NSIPS Web Site at URL: http://www.peoit-portal.navy.mil/peoit/communities/community.asp?UserID=2&CommunityID=218
2. KNOWN PRODUCTION PROBLEMS

This section contains a list of problems identified with the NSIPS program that have not been corrected with NSIPS Release 0.2.18.2 . These problems will be corrected in a future release.  Until the software has been updated, users are advised to call the CSC, unless instructed to do so otherwise in the USER ACTION column. Affected TACs have been identified for each problem, where applicable. Further questions should be addressed to the NSIPS Customer Support Center (CSC).

2.1 NSIPS Operator Panel Processor Problems

This table identifies problems associated with Operator Panel Processing in NSIPS. 

Description of Problem
TAC
Impact
User Action

Activity Gain Panel -- (Go => Gains => Activity Gain => Use => Activity Gain - Create => Report)

When completing an activity gain for an active duty member that will be assigned to a Naval Reserve Activity that supports units/members of the Naval Reserve, a check box will appear for the user to mark if the member is providing SELRES/FTS Support. When the check box is selected a window will appear for the user to enter the UIC of the command he/she is providing support. Updating this information in the current release of NSIPS does not update the database. (TT #219812)  
200
The Check Box in the Activity Gain panel does not work.
Upon save, the command UIC should be saved to the database and used in updating the RSTARS(TM) interface. User is to call the CSC to log a Trouble Ticket (TT). Correction to the problem will be in a future release of NSIPS.

Activity Gain Panel -- (Go => Gains => Activity Gain => Use => Activity Gain - Create => Report)

The Activity Gain (200)  TAC fail at NES with error code of   A4 (Invalid DEPTID)  when an Activity Gain is submitted without a previous loss and  reporting a period of absence. (TT #261940) 
200
The 200 TAC fails.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will remove the Activity Gain created so the site can re-submit gain transaction. Correction to the problem will be in a future release of NSIPS.

Activity Loss -- (Go => Losses => Activity Loss => Use => Activity Loss – Create)
The UIC Report To field in the Activity Loss panel group is pre-filled with the UIC that the member is being lost from, therefore the NSIPS record of the member is not being forwarded to the UIC Report To duty station.  (TT #280381)

The UIC Report To field in the Activity Loss panel group is pre-filled with the UIC that the member is being lost from, therefore the NSIPS record of the member is not being forwarded to the UIC Report To duty station.
User must validate against orders and ensure that the UIC Report To field has the UIC of the command where the member is reporting to as stated in the orders. If the UIC Report To duty station is not the future command, user will need to type in the correct UIC where the member is reporting to.  Correction to the problem will be in a future release of NSIPS.

All Members Table -- (Go => All NSIPS Member Request => Use => Request All - NSIPS Member) 
User cannot perform an All NSIPS Member Request (GO-GET) if the SSN is not present on the local server's All Members table. This prevents timely gains. 

Prevents timely gains since a Go-Get cannot be performed by user for an SSN.
User is to call  the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will insert SSN in the local server's All Members Table manually. Site can then perform an All NSIPS Member Request.  Correction to the problem will be in a future release of NSIPS.

*Availability -- (Go => Availabilities => Use => Change/Delete)

When an operator submits a deletion to an existing Avail, the user gets the following error message from Corporate: "007 Invalid Avail Class". The Avail Classification Code is not included in the message layout and should have been pulled from the Availability Table's Availability Classification Code Field.  (TT #282996)
AVL(001)
 The Availability Classification Code is not included in the message layout when a user submits a deletion to an existing Avail. User gets error message from Corporate: "007 Invalid Avail Class".
User is to contact the member’s Rating Detailer to request cancellation of existing Avail. Correction to the problem will be in NSIPS Release 0.2.19.0.

Cancel Strength Loss -- (Go => Losses =>Correct/Cancel Losses =>Use =>Cancel Loss – Create)
All Cancel Strength Loss (198) transactions errors out at NES with an error code of 2N (TRANS DATE OF OCCUR < EMR LOSS DATE). NSIPS uses the Loss Date as the date Strength Loss is cancelled vice the System Date. 
198
The 198 transaction fail at NES with a 2N error code.
Update the 198 transactions at NES and re-send the failed transactions. Correction to the problem will be in a future release of NSIPS.

Extensions -- (Go => Contract Administration => Extensions =>Use =>Extensions-Create => Extensions)

When user makes a Branch Class 32 Active Duty Reserve (ADR) Expiration of Active Obligated Service(EAOS) extension operative, the application updates both the Contract End Date and Expiration of Active Service fields.  This blanks out the Expiration of Reserve Enlistment (EREN) on the Extensions Inquire Panel, and erroneously updates the hard and soft EAOS/EREN.  Also, the user is able to make ADR extension operative before making the reserve extension operative.  
387/389
Hard and soft dates for EREN/EAOS are erroneously updated.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will update the EAOS and the Contract End Date of the record. Correction to the problem will be in a future release of NSIPS.

*Inactive Duty Training (IDT) -- (Go => Inactive Duty Training => IDT Unit => Use => Schedule => Schedule/Reschedule)

User scheduled drills for 6/13/02 and successfully cancelled both periods 1 & 2.  User then attempted to re-schedule drills for that same day to Type 6 (Drill Pay Add - Readiness Manning Period) and received the following error: "Type 6 cannot be selected if there exists another drill on the same day".

User is unable to replace cancelled IDT drills with Type 6 IDT for the same date.
User is to call  the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will take appropriate action . Correction to the problem will be in NSIPS Release 0.2.19.0.

Leave -- (Go => Leave Administration => Leave => Use => Leave - Create)  

The Leave Panel Group does not read the current member's record. This creates a job row that does not contain a Department ID thus preventing the user from accessing the record. In turn, user is unable to process Strength Loss. 

A record is created in the Leave Panel Group that does not contain a Department ID, therefore the record can not be accessed by the user.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will update the record. User then submits transaction.  Correction to the problem will be in a future release of NSIPS.

Legal -- (Go => Legal => Use =>Unauthorized Absence – Create => UA Report)  

NSIPS receives a 951(Declared a Deserter) and 200 (Activity Gain) TAC combination when a member is placed in Deserter Status.  When member has been returned from Deserter Status user encounters an edit against “overlapping periods” of time because the period of absence being reported is prior to his most recent report date.  
951/200
Unable to complete transaction in NSIPS so the error needs to be changed to a warning
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will update the record. User then submits transaction.  Correction to the problem will be in a future release of NSIPS.

Orders -- (Go => Orders =>Use => Transfer Information Sheet => TIS Summary)
When operator attempts to save the Orders – Transfer Information Panel, the following error message is received “Field does not exist – OPRID. (2,104)”.  

User is unable to progress beyond this Panel
User must use forms in existence prior to NSIPS implementation to document the information. Correction to the problem will be in a future release of NSIPS.

*Personal Data  -- (Go => Personnel Maintenance => Personal Data => Use => Personal Data - Create => Test Scores)
Test Scores (B29(S)) transaction is created for members attached to UIC other than 30646.  (TT #277388)
B29(S)
B29(S) transaction is created for members attached to UIC other than 30646.
User from UICs not in 30646, should ignore the B29(S) reject transactions in their Feedback report.  Correction to the problem will be in a future release of NSIPS.

Personal Data Panel -- (Go => Personnel Maintenance => Personal Data => Use => Personal Data – Create => Personal Info)

Applies to Reserves Only.  Error message '27200,198' appears upon any Personal Data panel entry and save attempt when the Data Confirm Checkbox field is set to "N" or blank, Citizenship  = CA (U.S. Citizen by Birth), and Birth State/Country field is blank for Reserve Enlisted members (DSC = 200). This enforces a mandatory update to the Birth State/Country field which is grayed out and not editable for the Reserves. (TT #246315) 
C50
Inappropriate Active/Recruit save edit on selected Reserve members are enforced in the Personal Data Panel. 
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will update the Birth State/Country for the SSN.  Correction to the problem will be in a future release of NSIPS.

Personal Data Panel -- (Go => Personnel Maintenance => Personal Data => Use => Personal Data – Create => BSC/NEC)

Applies to Active Duty Only. The Distribution Navy Enlisted Classification Codes (DNEC1 and DNEC2) fields on the Billet Sequence Code/Navy Enlisted Classification (BSC/NEC) panel do not accept alphanumeric entries. The fields only accept numbers.  (TT #244260) 
DNEC
Data cannot be saved if alphanumeric information is input in the DNEC1 and DNEC2 fields (for Active) on the BSC/NEC panel.
User is to call the site's EPMAC representative and request that the DNEC fields be assigned to the member.  Correction to the problem will be in a future release of NSIPS.

Personal Data Panel -- (Go => Personnel Maintenance => Personal Data => Use => Personal Data – Create => Personal Info) 

When the Data Confirm Checkbox field is =”Y” and Department ID <> 30646, an error message “Date and Type of Last Discharge must be entered when last branch and class was discharged” occurs . (TT #261519) 
C50
Unable to process transaction.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will update the Date and Type of Last Discharge.  Correction to the problem will be in a future release of NSIPS.

Personal Data Panel -- (Go => Personnel Maintenance => Foreign Language => Use => Foreign Language-Create) 

If the accomplishments contained in the Accomplishments table is other than foreign language, the value pulled for the Evaluation Method field is the first row of this table which sends up a null value and results in a failed B48 (Language Qualifications) message.  (TT #236310) 


B48
The B48 TAC is generated with a null value in the Evaluation Method. 
User is to call the CSC to log a Trouble Ticket (TT). CSC will forward TT to Tier 2 who will pull the values from the specific foreign language row that is being written.  Correction to the problem will be in a future release of NSIPS.  

RSTAR(TM)

The RSTARS(TM) Unit Records (tmunt) file is pulling in members who have been discharged, transferred or are outside of the Naval Reserve Activity (NRA).  (TT #254818) 

RSTARS(TM) will not allow an upload if the Unit Records file does not match the RSTARS(TM) Naval Reserve Activity (NRA).
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will modify the Unit Records file  at the site’s Local Server to include only the NRA prior to site doing an export. Correction to the problem will be in a future release of NSIPS.

RSTARS(TM)

The RSTARS(TM) download contain RBSC (pos 1-4), drill pay code (pos 5), AUIC (pos 6-10) and O/E Ind (pos 11).  The correct format for RSTARS(TM) download is O/E indicator in the first position of the record, RBSC (pos 2-5), Drill Pay Code (pos 6) and AUIC (pos 7-11).  

RSTARS(TM) download contains blank in the first position of the record.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will make an adjustment for the change in position number to the download file. Correction to the problem will be in a future release of NSIPS.

RTC Multiple Losses -- (Go => Losses => RTC Multiple Losses => Use => RTC Multiple Losses - Create)

User gets a message that "Another User has Updated the Panel" when trying to process a division. This occurs when a loss has been processed for a member of that division and a record already exists in the Entitlement Loss Stop Table. Also, this table is not in the cross reference table for the RTC Multiple Loss panel group. 



Unable to complete RTC Multiple Loss when processing a division if a record already exists in the Entitlement Loss Stop Table.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will stop the entitlement for the member that already exists in the Entitlement Loss Stop Table. Correction to the problem will be in a future release of NSIPS.

RTC Unique -- (Go => RTC Unique =>Use =>RTC Unique)

The Date of Last Discharge in the RTC Unique panel is not being written to the Active Table on supervisor’s approval.  (TT #261519) 

Members who matriculate through the Delayed Entry Program (DEP) may start out as BR/CL 32.
Correction to the problem will be in a future release of NSIPS.

Sailing Admin -- (Go => Diary => Sailing Admin => Use => Sailing Admin - Create => Embark/Debark Passengers)

When a member reports embarkation of a civilian passenger TAD, a CTAD (Change Number of days Civilian Is Embarked or assigned for TAD or TDY) TAC is erroneously generated. 


CTAD
CTAD TAC is generated erroneously.
Correction to the problem will be in a future release of NSIPS.

Strength Gain (Officer)  -- (Go => Gains =>Strength Gain =>Use => Strength Gain - Create)

Officer Prospective Gain records are pre-staged with Action = TPM (Transaction Process Monitor) and Action Reason = DA (Data Alignment) in the Job Table.  The personnel data strength gain process does not work correctly with these values.  
F8
Updates to the audit/base tables do not occur and related messages are sent with invalid data causing rejects.
User is to call the CSC to log a Trouble Ticket (TT). Correction to the problem will be in a future release of NSIPS.

Strength Loss  -- (Go => Losses => Strength Loss => Use => Strength Loss - Create)

User cannot separate member who is retained in service using a loss date after the hard EAOS. User receives error indicating that EAOS has expired.  (TT #262518) 



Unable to separate member who is retained in service using a loss date after the hard EAOS.
User is to call the CSC to log a Trouble Ticket (TT). CSC is to forward the call to Tier 2 who will update EAOS to date member is discharged. User then does the Strength Loss. Correction to the problem will be in a future release of NSIPS.

2.2 Unsolicited TAC Related Problems

Unsolicited Transactions are actions that originate at Corporate Asset (CA) and are propagated to NSIPS via the Corporate Asset Interface (CAI). These transactions initiate mandatory updates to NSIPS. The table below identifies problems with specific unsolicited TACs. 

Description of Problem
TAC
Impact
User Action

Correct /Cancel Losses Panel 
The Cancel Erroneous Activity Loss Unsolicited MGTR 298 TAC fails with the error "There is no matching Job Table row to cancel for this TAC". DA code passes only those transactions when the gain and loss occurs on the same day such as the TAC Effective Date = Activity Loss Table's Report Date. DA code needs to be modified to where the TAC Effective Date matches the Activity Loss Table's Loss Departure Date. 
298
The Cancel Erroneous Activity Loss Unsolicited MGTR 298 TAC fails.
User is to call the CSC to log a Trouble Ticket (TT). Correction to the problem will be in a future release of NSIPS.

2.3 Data Alignment Problems

This table identifies problems associated with aligning NSIPS data records with the data that resides in the Corporate Assets.  Data Alignment is primarily used to maintain synchronization between personnel records. It is also used in synchronizing some system table data.

Description of Problem
TAC
Impact
User Action

Data Alignment

The All-NSIPS server had hard drive space resource problems.  TPM would apply the month and day correctly, but instead of applying the year stored in the DA transaction table it applied the year 2019 or 2020.   

Wrong year is being shown.
User is to call the CSC to log a Trouble Ticket (TT). Correction to the problem will be in a future release of NSIPS.

Data Alignment
Strength/System Consolidation for Accession and Training (SCAT) Gain / Activation of Reserve AR1 (1Fl/1SRs) MGTR Unsolicited TAC are failing from Data Alignment with the error. " The 1FL/1SR TAC does not meet any criteria specified in requirements". (TT #239374)  
1FL/1SR
(1FL/1SRs) MGTR Unsolicited TAC fails when only Reserve record exists.
User is to call the CSC to log a Trouble Ticket (TT). Correction to the problem will be in a future release of NSIPS.

Data Alignment 

The Date of  Last Discharge  is not being aligned after initial gain. 

Blank value causes edit failures for members who should have a previous discharge date on file.
User is to call the CSC to log a Trouble Ticket (TT). Correction to the problem will be in a future release of NSIPS.

Data Alignment 

One of the Activity Gain (200) TAC Error Return Business Rule states that if the UIC <> Department ID in the Job Table and the Report Date < Report Date in the Job Table, and the UIC Report To is = to the Department ID in the Job Table and the Action in the Job Table is Activity Gain, then rollback to previous row in the Job Table. When these conditions are met Data Alignment updates the incorrect job row with the Loss Report Date value. (TT #262938) 
200
The incorrect job table row is updated with the Loss Report Date value.
User is to call the CSC to log a Trouble Ticket (TT). CSC will forward TT to Tier 2 who will remove the Activity Gain leaving only the Loss row. User can then re-submit the gain.  Correction to the problem will be in a future release of NSIPS.  

Data Alignment

DA does not select the latest Contract Begin Date from the Contract Table and therefore does not calculate the operative extensions based on other business rules.  
383
When handling the Unsolicited 383 (Agreement to Extend Enlistment, Operative) TAC, DA is not selecting the latest value in the Contract Table.
User is to call the CSC to log a Trouble Ticket (TT). CSC will forward TT to Tier 2 who will correct the Contract Begin Date of the record. Correction to the problem will be in a future release of NSIPS. 

Data Alignment 
The Strength Gain (F8) MGTR Unsolicited transactions are being rejected by Data Alignment with error of  "Out of Sequence Gain/Loss Error". This error should not be occurring. (TT #239374)  
F8
Strength Gain (F8) MGTR Unsolicited TAC are not applied when only Reserve record exists.
User is to call the CSC to log a Trouble Ticket (TT). Correction to the problem will be in a future release of NSIPS.

2.4 System Administration Problems

This table identifies problems associated with NSIPS System Administration.
Description of Problem
TAC
Impact
User Action

* System Administration

Several System passwords are reset to a default  value when a new release is applied to the NSIPS local server. The passwords should not be reset.

Several system passwords are reset to a default value.
The NSIPS System Administrator  needs to change the passwords for  these accounts after loading a new NSIPS release. Correction to the problem will be in a future release of NSIPS.

APPENDIX A–ACRONYMS AND ABBREVIATIONS

ACRONYMS AND ABBREVIATIONS
Abbreviations are in Italics

ADR
Active Duty Reserve

AUIC
Activity Unit Identification Code

BR/CL
Branch/Class

BSC
Billet Sequence Code

CAI
Corporate Asset Interface

DA
Data Alignment

DEPTID
Department Identification

DNEC
Distribution Navy Enlisted Classification 

DSC
Duty Status Code

EAOS
Expiration of Active Obligated Service

EMR
Enlisted Master Record

EREN
Expiration of Reserve Enlistment

FTS
Full Time Support

MGTR
Daily Transmittal of  Transactions

NEC
Navy Enlisted Classification

NES
Navy Enlisted System

NRA
Naval Reserve Activity

NSIPS
Navy Standard Integrated Personnel System

OE
Officer Enlisted

OPINS
Officer Personnel Information System

PS
PeopleSoft

RBSC
Reserve Billet Sequence Code

RHS
Reserve Headquarters System

RSTAR(TM)
Reserve Standard Training Administrative Readiness Support Training Module

RTC
Recruit Training Command

SC
Strength Code

SCAT
System Consolidation for Accession and Training

SELRES
Selective Reserve

SPR
Software Problem Report

SSN
Social Security Number

STASS-RTM
Standard Training Activity Support System - Recruit Training Module

SYSADM
System Administrator

TPM
Transaction Process Monitor

TT
Trouble Ticket
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